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Quick Start

Welcome to Outlook Email Archive (OEA), the simplest and quickest way
to archive your email messages.
OEA can archive your email in three different ways:
- Archive email and/or attachments in the Finder.
- Export or append email in a text file that can be read by a text editor or a
word-processing program.
- Export email in tab-text format that can be imported, for example, in
FileMaker Pro. For this export function a free template is enclosed in the
“Extra” folder in the Outlook Email Archive folder.

Launch Microsoft Outlook Express.

Launch OEA. A main window appears:

Click on the top-left icon. 

The folders and subfolders of your Microsoft Outlook Express program will
be loaded in the same sequence and positions as they are in your
application.The first popup menu will change to read “Select a folder…”
and you can then choose the folder to archive. After you choose a folder,
the number of emails contained in the chosen folder will be displayed.
Only if a folder contains messages will the button “archive” be active,
otherwise it will be disabled.

From the popup menu “Type of Archive” choose your archive method:

From the popup menu “Archive using” choose “received date” or “sent
date” for archiving/exporting email:

Into the last textbox, “Destination folder for Archive” drag the folder/file
that will be used for the final destination of your archive. You can also click
on the left icon and the standard dialog box for choosing a folder will
appear.

At this point click “Archive” and OEA will start the archiving process and
show you the progress of the operation.
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The resulting Finder archive will be like the one in the following example:

All emails are grouped by day. In the example, the number (089) before the
date 29 March 2000 indicates the progressive number of the day of the
year (from 1 to 365 or 366); inside this folder, you will find all emails
received that day with the “Outlook ID Message” and the email (received or
sent) time. At this level OEA saves the email + attachments.

The other two choices from the popup menu are for archiving only emails
or only attachments.

Emails are saved in the Simple Text format. Attachments are saved in the
original format (Stuffit, Compact Pro, native files…).
For browsing your email archive you can use Apple Sherlock Technology
and search inside the selected folder previously indexed for search in the
contents (refer to page 10 for more information).
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Type of Archive

Outlook Email Archive (OEA), can manage six different possibilities that
produce three kinds of archives.

The first three choices (Emails + attachments - Only emails - Only
Attachments) produce a “Finder Archive”, a structure of folders and
subfolders where the emails are stored by day of the year and time of the day.

In this example the structure of folders and subfolders of Microsoft
Outlook Express is shown.

When first using Outlook Email Archive I suggest creating the same
structure of folders and subfolders in the “Finder” that are in Microsoft
Outlook Express.
Later simply drag and drop the destination folder from the Finder to the
“Destination folder for Archive” textbox in OEA’s main palette.
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Export new text file - Append to text file…

When the command “Export new text file” is selected, a blank destination
file is created and then filled with the entire contents of the emails
messages:

When the command “Append to text file…” is chosen, OEA appends the
email messages to the end of messages in an existing file.
When the user selects this command a dialog window appears prompting
the user to select a text file for appending emails.

Export tab-text file

The command Export tab-text file is for generating a text file useful for
importing data into a database like, for example, FileMaker Pro.
A free template for FileMaker Pro 4.0 is included (in the folder “Extra”) and
is “open.” Users can change or modify the scripting and layout.
Before importing data into FileMaker it is important to select from the
popup menu of FileMaker Pro the command “Tab-Separated Text” as in
the following example:

The following fields are exported:
Folder: the name of Microsoft folder or sub-folder where email is located.
From: the sender of email (display name and email).
To: list of addresses (display name and email separated by commas).
Cc: list of addresses (display name and email separated by commas).
Bcc: list of addresses (display name and email separated by commas).
Date: the date of email received or sent.
Attachments: the list of attachments (separated by commas).
Subject: the subject of email.
Body: the content of email.



7

Preferences

You can set the date format for the folders created with the following kind
of archives:
Emails + attachments
Only Emails
Only attachments

by choosing from the popup one of the five settings:

Important Note:
The length of FileMaker Pro text fields are limited to 64 KB.
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Log

The log window reports all the tasks executed.

Click on button “Clear” to clear the “history” log.

In the popup menu “Creator Type” it is possible to define the creator type
for text files generated with the functions:
Export new text file
Append to text file…
Export tab-text file

The three check boxes can be used to omit from the archive process the
categories of Unread Emails, Flagged Emails and Edited Emails.

In the popup menu “Date format for tab-text file” choose the correct
setting for your FileMaker Pro archive.
Two settings are available:
mm-dd-yyyy (USA format)
dd-mm-yyyy (Euro format)

Example:
Choosing the first setting (USA) results in the email date 14 May 2000,
being written to tab-text file as 5-14-2000.
Choosing the second setting (Euro) results in the date being written as
14-05-2000.
This is important for correct import of data into FileMaker Pro archives.

All settings chosen are saved automatically for next use of OEA.
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Be sure that you have enough space on your Hard Disk, because Microsoft
OE used to duplicate and save the old and uncompacted files naming them
“Old Message” and “Old Database” respectively.
So, at the end of this task you should trash these old files (labeled green in
the picture above).

Important Note:
If you import emails from Microsoft Outlook Express 4.5 the received dates
are reset at the moment of the operation.
To check on this “Microsoft Bug” you can include a “Received Date
column” from the View menu in Microsoft Outlook Express.

Tips for Microsoft Outlook Express
Microsoft Outlook Express creates a folder for each user profile.
All of these folders are placed inside the “Identities” or “OE User(s)” folder
in the Microsoft Outlook Express folder.
For instance, we have three users as well as three main folders: me, my
wife and my son. Inside each folder is the same structure: all emails are
stored in a single file named “Messages” and the Microsoft Database is
stored in a file called “Database”.

Creating new messages in Microsoft Outlook Express increases the size of
these two files. When messages are deleted, Microsoft Outlook Express
DOES NOT reduce the size of these two files.
To reduce this free and wasted space, you have to compact the two files
using the following this procedure:
Launch Microsoft Outlook Express holding down the option-key just before
the splash screen appears and until you see the following dialog. Click on
the button “Yes”.

After some minutes, at the end of this task, you will see a dialog which
notifies you that all the files have been compacted successfully. Now, you
can check to see how much smaller the files “Message” and “Database”
are in the Finder.
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Tips for Outlook Email Archive
To obtain the best performance from OEA, we suggest you disable antivirus
programs (like Virex) by switching them off from their Control Panel, and if
you opened “FileMaker Pro”, quit it (it used to make the machine too
busy).

You should know that if a filter is on (see the Preferences), the “Get Info
about emails” time will be longer.

You can store the “OEA Finder Archive” in a Disk Image you created before
using utilities like “Apple Disk Copy”. Launch the “Apple Disk Copy”
program and select from the “Image” menu the command “Create New
Image”. A dialog will appear. Choose a name and size for your new “Disk”.

Concerning the size you should assign to your disk: you should know that
the data extracted from Microsoft Outlook Express by OEA, are
non-encoded, therefore the OEA data will use less space on the disk than
Microsoft Outlook Express did.

Click on the “Save” button and after a few seconds click on the “Erase”
button. The disk will be created and shown on your desktop.

Switch to the OEA application and choose the new disk as the destination
disk/folder.

You can also index this disk using the Apple Sherlock application.

Searching for some emails (using the “find by content” feature) is very fast
on the indexed disks. Sherlock stores the invisible index file inside the disk
itself, thus when you copy the disk image file, you will copy the index
automatically and you will not have to re-index your data again.

In this way, your archive is independent and you can copy to another Mac
and perform every kind of searching… using Apple Sherlock.

Of course, you have to update your Sherlock index every time you perform
a new “Archiving” from OEA.
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About FileMaker Pro Template
The templates inside the folder “Extra” can be used for archiving all emails
exported with the function “Export tab-text file”.
The templates are in FileMaker Pro, versions 4 and 5.
Because FM Pro can manage dates in two different ways when the user
enters data from the keyboard (as mm-dd-yyy or dd-mm-yyyy, according
to the language and settings of your MacOs) it is necessary before using
the template to follow these steps:

1. Open the template in FileMaker Pro.
2. Choose from File menu the command “Save a Copy As…”
3. Rename the file and choose from the popup menu the option “clone (no
records)”
This command changes the internal setting of the template concerning the
entry of some values like “Date”.
4. Close and open the new saved template.
5. Create a new record and type in the field “Date” the “Christmas of
December 2000” date as you usually type in Filemaker Pro (according to
the language and settings of your MacOs).
6. Press enter.
7. Because the field date is formatted to show the date as “ddd Month
yyyy,” if you see 25 December 2000 (in your language), all is OK.
8. Delete this record and import the data exported from OEA (please check
the exporting settings in the “Preferences” window.
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History Version
1.9.5
User can now define the name and location of file created with the
functions “Export new text file” and “Export tab-text file”.
The routine “Export tab-text file” now removes possible TAB characters
from the fields From, To, Cc, Bcc, Attachments and Subject.
Minor internal optimization and changes.
Update of manual.pdf.

1.9
The routine “Export tab-text file” has been rewritten: now is 40% faster
(especially with emails with multiple addresses).
The date is now exported (in the “Export tab-text file”) as “real date” and
not as “text” date.
In case of errors OEA will not stop the execution but instead will write a
log file inside the OEA folder called “OEA Errors Log”.
The file menu is now disabled during the archiving process.
The textbox “Destination file for Archive:” is now disabled during the
archiving process.
The window “Report” has been redefined and now includes a count of the
number of errors.
OEA now checks, before starting the archiving process, to determine if
FileMaker Pro is open.
Numerous modifications have been made to the FileMaker Pro template
“OEA Email DB” (now converted to FM Pro 5).
A free utility is enclosed in folder “Extra” for updating existing data
(generated with OEA before version 1.9) concerning the “date” in FM Pro.

1.8
Added the “skip emails” feature. There are three new check-boxes in the
Preferences area:
• Unread Emails
• Flagged Emails
• Edited Emails
The user can choose the destination folder/disk when archiving using
“Export new text file” and “Export tab-text file”.
The user can also archive the data using the MM-DD-YYYY date format

(see the Preferences).
In the unregistered version the user can process 9 emails (instead of
previous 6)
The manual.pdf has been updated with tips and suggestions for better use
of OEA and optimization of Microsoft Outlook Express.

1.7
Added window “Log” where OEA reports all the tasks executed. 
Added four kinds of settings for date format in the window “Preferences”.
Added support for AppleWorks in the section “Creator Type”.

1.6
Added support for exporting with the functions “Export new text file -
Append to text file - Export tab-text” addresses related to “To”, “Cc”, Bcc”.
Addresses are exported with display name and email address (e.g. John
Smith jsmith@aol.com).
Multiple addresses are supported.
Enhanced info during export progress.
Rewritten “Get info” routine. Now the progress bar is shown.
Minor changes of report window.
Optimized code.

1.5 Beta
Added support for exporting emails in tab-text format for quick importing
into FileMaker Pro (included is a free template).
OEA now supports export/append for long email messages (more than 32
Kb). Now the structure of folders and subfolders loaded from OEA in the
popup menu is in the same sequence as Microsoft Outlook Express
(including indentations).
Fixed the creator of Microsoft Word for export/append functions.
Fixed the received/sent date for export/append and export tab-text
functions.
Added “Preferences” window.
More than 40% of the code rewritten and cleaned.
For unregistered version user can process six emails (instead of previous 3).
Minor changes of the user interface.
1.4
Compatible with the last version of Microsoft Outlook Express 5.02.
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Added support for generating a export TXT file with a creator of one of the
following applications (Teach Text, BBEdit, Tex-Edit Plus, MS Word);
choose from OEA menu the command “Creator Type for Export” and click
on icon.
During the archiving process all popup and textbox menus are now
disabled.
Added the name or names of attachments in the “Export TXT file” process.
When the user chooses from the popup menu a folder, the number of
emails are now shown in the left bottom corner of the OEA window.
Changed the display dialog about the export file.
Fixed a bug in the popup “Archive using” introduced in the 1.3 beta.

1.3 Beta
Added support for exporting all emails in one TXT file that can be viewed
with a text editor like BBEdit or Tex-Edit Plus.
User can append emails to an existing file or create automatically a new
one for each session.
Added support for exporting only attachments.
New Finder icon.

1.2
OEA now reads and supports the entire structure of folders and subfolders
in Microsoft Outlook Express without limiting levels. User can now chose
subfolder without switching between the programs.
Added popup menu for archiving emails based on received date or sent
date.
Added popup for archiving email + attachment or email only. During the
archiving process the number of emails exported are now shown (e.g.
100/650).
In report window OEA now shows the elapsed time for performing the
operation.
Added message in report window when user deletes email (moves emails
in folder Deleted Items).
The drag-over-destination-folder textbox now performs controls. Rewrote
and optimized routines.
Improved speed.

1.1
New “Report” window that informs the user about: total number of emails
found, emails archived, and emails skipped (because already archived).
Position of main window of OEA is now remembered at the next relaunch.
User can drag the destination folder over the icon or textbox of destination
folder (drag & drop).
User can now interrupt the archiving process pressing command-shift-
period.
OEA now check when the user presses button “archive” to see if Microsoft
Outlook Express in open.
Fixed bug that causes OEA report an error if user doesn’t select a
destination folder. Added button “Delete Emails” for moving all emails from
selected folder to folder “Deleted Items” in Microsoft OE.
Optimized code.

1.0
Initial Release.

About Registration and Pricing:
Outlook Email Archive has the following pricing:
single user licenses, $15 per user (US Dollars)

A Site License costs $200 and covers all locations for your organization
within a 160 kilometer (100 miles) radius of your site.

About Registration: 
Paying for the Outlook Email Archive is fairly simple.
There are two methods.
On the Web (quick, easy and secure payment on-line) and by “Register”
application (off-line).

To register on the web:
Go to the web page http://order.kagi.com/?V8B
1 - Fill the form with your name, email, address, and how many copies you
want.
2 - Click on the button “Continue” and it will appear the invoice form.
3 - Fill the fields regarding your Credit-Card datas and then click on the
button “Purchase”. That's all.
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the Register application and send it to the address shown on the form,
which is:

Kagi
1442-A Walnut Street #392-V8B
Berkeley, California 94709-1405
USA
You can pay with a wide variety of cash from different countries but at
present if you pay via cheque, it must be a cheque drawn in US Dollars.
Kagi cannot accept cheques in other currencies.

If you have a purchasing department, you can enter all the data into the
Register program and then select “Invoice” as your payment method.
Print three copies of the form and send it to your accounts payable people.
You might want to highlight the line that mentions that they must include a
copy of the form with their payment.
Kagi cannot invoice your company, you need to act on my behalf and
generate the invoice and handle all the paperwork on your end.

Please do not fax or email payment forms that indicate Cash, Check or
Invoice as the payment method. As far as we know, there is still no
technology to transfer physical objects via fax or email and without the
payment, the form cannot be processed.

Payments send via postal mail take time to reach Kagi and then up to 10
days for processing. Again, if you include a correct email address, you will
hear from Kagi when the form is processed.

For any information about the software of for notify me bugs or enhancement:
Stefano Cappello
Email: capste@kagi.com
Web Site: http://digilander.iol.it/capste/
For further information about the payment:
Kagi - Email: sales@kagi.com Web Site: http://www.kagi.com

If your browser supports, you can switch on SSL secure payment form
(it's the internet international standard secure form of payment).
Your invoice will be processed in 24 hours. Therefore, you will receive by
me via Email a little text file “Registration Code” to put inside the folder
“Outlook Email Archive”

To register off-line by the “Register” application:
Launch the “Register” application, enter your name, email address and
number of single user licenses or other licenses you desire.
Save or copy or print the data from the Register program and send the
data and payment to Kagi.
Kagi handles my payment processing.
See the end of this document for more specific payment information.
The fastest way (round 3 days) is to save the invoice to a text file,
choosing “via email,” and therefore send that text file via email as
attachment to sales@kagi.com. You can also open the invoice text file with
an editor (e.g. SimpleText) selects all the text, copy and paste into the
email so as it is (without any changement). Don't forget to include your
email address. We need to send to you the Registration Code by email.
Once your message is received by Kagi, you will receive (in round 3 days)
by me via Email a little text file “Registration Code” to put inside the folder
“Outlook Email Archive”.

Detailed Payment Info:
If paying with Credit Card or First Virtual, you can email or fax the data to
Kagi. Their email address is sales@kagi.com and their fax number is +1
510 652-6589. You can either Copy the data from Register and paste into
the body of an email message, or you can Save the data to a file and you
can attach that file to email message. There is no need to compress the
data file; it's already pretty small. If you have a fax modem, just Print the
data to the Kagi fax number.

Payments sent via email are processed within 3 to 4 days. You will receive
an email acknowledgement when it is processed. Payments sent via fax
take up to 10 days and if you provide a correct internet email address you
will receive an email acknowledgement.

If you are paying with Cash or USD Cheque you should print the data using


